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Introducing Microsoft Office OneNote 2007

Welcome to Office OneNote 2007, a software program that helps you efficiently manage your notes and information.  Office OneNote 2007 is included in the 2007 release of the Microsoft Office system of programs, servers, and services for information workers.

The New World of Work

In today’s world of work, people are increasingly required to stay on top of ever-growing volumes of information, and teams are being asked to work together more than ever before.  People have lacked a tool that’s flexible enough to capture the many different types of information that they must deal with every day, and organizations lose valuable information because it isn’t captured or because it’s lost in e-mail.  When tasked with working together, teams default to e-mail for information sharing and collaboration, and it’s increasingly difficult to get teams “on the same page”.

What is Office OneNote?
Enter Microsoft Office OneNote 2007, a digital notebook that gives you the flexibility to gather and organize virtually any type of information—from typed text, audio, and video to handwritten notes and drawings, technical graphics, and research from the Web and other applications—all in one place.  

With your notes and information in one place, OneNote provides powerful search capabilities that allow you to easily find information you couldn’t before, such as spoken words in audio and video recordings and text in scanned documents or pictures.  
New to OneNote 2007 are shared notebooks, which give teams one place to gather notes, research, and information related to a project, customer, or meeting.  With shared notebooks, users can all work together and share information more effectively—whether online or offline—and OneNote automatically merges and updates everyone’s changes. 
Now you can work more efficiently and find what you need more quickly, using the digital notebook capabilities Microsoft Office OneNote 2007 provides for gathering, organizing and sharing your notes and other information.
Office OneNote 2007 Features
The 2007 release of Office OneNote includes a range of enhancements that make it easier than ever to gather, find, and work together on information.  You can now more quickly find the content you need, and you can easily search for information in multiple types of content.  Also, OneNote 2007 offers stronger integration with other Office programs, such as Office Outlook and Office SharePoint Server and Windows SharePoint Services (WSS), and enables closer collaboration among team members.  You also now have more control over your information—OneNote 2007 supports multiple notebooks, which enable users to distinguish between their personal notebooks and shared, team notebooks.

Features to Simplify Working Together

	Office OneNote 2007 Features
	Benefits

	Support for multiple notebooks 
	Multiple notebooks enable you to better organize your own information and allow you to set up shared notebooks for projects, recurring meetings, or other teamwork.

	Enhanced notebook sharing
	Shared notebooks give teams one place to collect project and team notes and other content.  Team members can work on a notebook simultaneously, or at different times; updates happen automatically across all team members’ copies of the notebook.

	Offline read/write access to shared notebooks
	Offline read/write access enables you to make changes to shared notebooks while offline; changes merge automatically once re-connected.

	Ability to store shared notebooks on WSS sites
	Shared notebooks stored on WSS sites enable organizations to digitize, store, and easily search new types of content, making a richer set of data available for the corporate record.


Features to Increase Personal Effectiveness

	Office OneNote 2007 Features
	Benefits

	Enhanced integration with Microsoft Office Outlook
	Two-way task synchronization between OneNote and Outlook and the ability to take notes in OneNote on any Outlook item make it easy to keep track of action items and other important information.  

	Improved integration with Windows Mobile® powered devices
	Be more productive while mobile by taking notes, gathering information including pictures from your camera phone, and viewing your notes while away from your computer, on your Windows Mobile powered device.

	Enhanced integration with Office Communicator
	Take notes on a Communicator conversation quickly and easily, and keep your notes in your OneNote notebook, so you can keep valuable information for easy re-use.

	Gather many types of content in OneNote
	Make more informed decisions by gathering all of your unstructured information in one place—OneNote enables you to print any electronic file to your notebook, send Web pages to OneNote from Internet Explorer, embed Office documents and e-mails in OneNote notebooks, and record audio and video.


Features for Managing Content

	Office OneNote 2007 Features
	Benefits

	Instant Search
	Find what you are looking for quickly by using Instant Search, which leverages the Windows Desktop Search engine and indexes your content for you in the background.

	Optical Character Recognition (OCR) Search
	OneNote’s OCR engine reads text in scanned documents, pictures, or images, enabling you to easily find information that you couldn’t before.

	Audio Search
	Quickly find spoken words in audio and video recordings to maximize your productivity.

	New navigation pane
	Organize your information according to your needs and keep the most important data at your fingertips with the new navigation pane, which supports drag-and-drop functionality and hyperlinks among sections of your notebook.

	Import/export application programming interfaces (APIs)
	Reduce errors and avoid re-entering data into multiple systems, such as CRM and document management repositories.  OneNote import/export APIs enable you to connect OneNote data directly to those systems. 


Getting Started with OneNote 2007
Getting started with OneNote is as easy as opening the program and beginning to type anywhere on the page.  Unlike Word or other document processing applications, OneNote offers you the flexibility of writing wherever you want—as you would with a paper notebook.  You can click anywhere on the Office OneNote 2007 page surface and begin to type, draw, hand-write, or record information. 

Like a paper notebook, there is no Save button in OneNote—everything is automatically saved as you write it.  Even if you turn off the computer or close the program quickly, you do not need to worry about losing important information—it is already saved.  OneNote also automatically creates backups of your notebooks, so you have the peace of mind of knowing that your information is protected.
When you first open OneNote, you will see a page like the one pictured here.  You’ll find that OneNote has a very familiar appearance because it is structured much like a paper notebook, with pages and sections for organizing different categories of information.  
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Figure 1: The opening view of Office OneNote 2007. 

Anatomy of a OneNote Notebook

What are the key features of OneNote notebook pages?  Let’s look at the distinction between OneNote pages and sections, which are simply different kinds of containers for organizing information. 
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Figure 2: The layout of an Office OneNote 2007 page.
An Office OneNote 2007 notebook contains one or more sections; sections contain one or more pages.  Sections appear as colored tabs on the top portion of the Office OneNote 2007 page surface.  The pages in a given section appear as tabs along the vertical axis of the OneNote page surface.  You can add an unlimited amount of pages to any OneNote section, so you’ll never run out of “paper” in your notebook. 

Notebook Section Tabs

Near the top of the OneNote page are tabs representing the sections within a notebook, which are much like sections in a three-ring binder.  You can create as many sections as you need and customize them by naming them after different projects, types of meetings, or anything you want.  For example, project managers might have a different notebook for each project, with different sections for each component of a project (such as vendor meetings, client meetings, and project timelines).

Automatic Save
A benefit of a paper notebook is its permanence; once you write something down on paper, it is always there.  Office OneNote 2007 offers the same kind of convenience.  There is no Save button in Office OneNote 2007—everything is automatically saved as you write it.  Even if you turn off the computer or close the program quickly, you do not need to worry about losing important information—it is already saved.

Support for Multiple Notebooks
You can use Office OneNote 2007 to create multiple notebooks, so it is easier to organize your work.  For example, you can organize your work by project, special topics, or by personal information and team information to share with others.  When you open Office OneNote 2007, you will see two notebooks in the left margin of the page, and you can create additional notebooks as needed. 
Gathering Your Notes and Information in OneNote

Most people have no single place where they can capture all the different pieces of information that they use in the course of their work.  Some information resides in e-mail messages, some is stored on Web sites, and some details might be in a file folder or on a pad of paper, and it takes time to locate the information you need.  Wouldn’t it be great if you could gather in one place all the ideas, the meeting notes, the Web research, and everything else that you need to do your work? 
That is what Office OneNote 2007 is all about: giving you the ability to gather, organize, integrate, and quickly find all the information that your work requires—in one place. 
Creating a New Notebook

You create a new notebook simply by selecting “File/New Notebook” from the OneNote menu bar. 
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Figure 3: The New Notebook Wizard.

Typing Text into OneNote
When you take notes using a pen and paper, you can place your pen anywhere you want on the page and just start writing.  Office OneNote 2007 provides the same flexibility. Simply click anywhere on the OneNote page surface and you can start capturing your ideas.
With Office OneNote 2007, you can easily group related matters.  For example, before a meeting you might create an area for notes (a “container”) titled Agenda, a second area titled Attendees, and a third titled To Do, with a table to capture action items.  During the meeting, you can quickly add relevant information to any of those three areas—or click somewhere else on the page to start a completely new thought.  
Managing Containers of Content

You can even move whole note containers by clicking a container’s outline—visible when the cursor hovers over it—and dragging it elsewhere on the page.  By dragging one container into another, you can combine the content from both containers into one.  Similarly, by selecting some of the content of a container and dragging it away from that container’s outline, you can split one container into two.  You can also cut or copy a container and paste it on another page altogether.  
If you want to work with a portion of content, you can use OneNote’s Lasso tool to draw an outline of any shape around text, a drawing, or any other type of content, and then you can cut, paste or move that content.
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Figure 4: The Lasso tool.
Printing Information into OneNote
OneNote 2007 has a print driver that allows you to print any document to OneNote, just as you would to a printer.  This feature allows you to save any document as an image in your OneNote notebook that can then be annotated.  Anything that you used to print out and store in file folders can now be printed and saved directly to OneNote, enabling you to keep all of your important information at your fingertips. 
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Figure 5: Printing a document to OneNote.
Sending Information to OneNote from Other Office Programs

You can paste into Office OneNote 2007 virtually anything that can be captured using the standard cut-and-paste features of the Microsoft Windows operating system.  In addition, Office Outlook 2007 has a Send to OneNote button for calendar items and contacts, and Office Communicator 2007 has a Take Notes button in the Communicator window.  You can also paste hyperlinks to other files and Web sites into a OneNote notebook. 
Embedding Office Files, E-mails into OneNote
In addition to the ability to cut and paste between Office System applications, you can use Office OneNote 2007 to embed files into a OneNote notebook.  You can drag any file from Windows onto a OneNote page, or you can insert the file into the page using the File option on the Insert menu.  If you are working on a project, you are likely to use different types of documents to track pieces of the project.  Now you can keep these documents together with everything else in Office OneNote 2007.

Gathering Web Research into OneNote

OneNote 2007 is an ideal companion to Web research, and offers several features that let you conduct research more efficiently by capturing all of the web-based information you need in one place.  For example, the Side Note feature allows you to drag and drop research onto a OneNote page without ever leaving Internet Explorer (hint:  right click the OneNote icon in your system tray, and click Open New Side Note).  Additionally, the Screen Clippings feature allows you to select portions of web pages or other content on your screen and automatically paste them into OneNote (hint: right click the OneNote icon in your system tray, and click Create Screen Clipping).  The Send to OneNote button in Internet Explorer allows you to export entire Web pages to OneNote with a single mouse click.  And, of course, you can just manually copy and paste information from a Web site into OneNote.  When you do, the source URL is automatically inserted with the information, so you can click the link and quickly return to the source of the information. 

Capturing Information on Your Windows Mobile® Powered Device

Office OneNote 2007 makes it easier than ever to integrate your Windows Mobile-based Smartphone or Pocket PC into your information-gathering toolset.  You can copy portions of your Office OneNote 2007 notebook onto your device, so you have the information you need when you are carrying only your device.  
You also can capture new information on your Smartphone or Pocket PC and then easily integrate it into your OneNote notebook.  For example, pictures taken with the camera on your Smartphone can be integrated into your OneNote notebook, and, provided the quality of the image is high enough, any text in the picture will become part of your OneNote searchable index.  You can also use the microphone on your device to record voice notes and integrate them into your OneNote notebook.  
To use OneNote’s capabilities on your Windows Mobile powered device, simply connect your phone to your PC and ensure that ActiveSync® is turned on.  OneNote will automatically prompt you to download OneNote Mobile to your device.
Inserting Images into Your Notebook
Any printable document can be inserted as a color image into your OneNote notebook.  For example, you can insert a resume document into OneNote prior to an interview, or an Office PowerPoint presentation prior to a meeting.  By inserting the image of the file into your notebook, you can annotate it and save both types of information in the same place.  
To insert a document as an image, click Files as Printouts from the Insert menu and select the file you wish to insert into OneNote.
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Figure 6: You can insert any printable document as a color image.

Import and Export APIs
Microsoft is publishing the application programming interfaces (APIs) to Office OneNote 2007 so that partners and developers can extend the capabilities of Office OneNote 2007 even further.  With these APIs exposed, developers can make it easy to import content and data directly into Office OneNote 2007 from their applications.  It is also easy to move information captured in Office OneNote 2007 into other applications, such as document-management applications and more.  The full export API provides a seamless and user-friendly direct link to other Line of Business systems you use, enabling you to avoid time-consuming and error-prone data re-entry into multiple systems. 
Handwriting and OneNote

If you have a Tablet PC or a pen input device, you can use your digital pen to take handwritten notes or draw pictures and diagrams in Office OneNote 2007.  If you are using a Tablet PC, you can either convert your handwriting to text, or leave it as handwriting, if you prefer.  The OneNote search engine treats handwriting entered on a Tablet PC the same as text.  You can use the search capabilities of Office OneNote 2007 to find information entered as handwriting or text, and Office OneNote 2007 finds the entry either way. 
You can also easily mix handwriting and text on the same page.  You can change the order of handwritten items in a list using drag and drop, and you can also add bullets and numbering to your handwritten notes and mark them with Note Flags. 
Next-generation Ink Parser

While most people use Office OneNote 2007 on a desktop or laptop computer, those that use OneNote on a Tablet PC will get to take advantage of the new Tablet PC Ink parser.  Office OneNote 2007 continuously evaluates and revisits ink input.  This ongoing analysis of your inking activities provides a handwriting recognition and ink-to-text conversion experience that is more accurate and robust than ever.

Creating a Drawing in OneNote

OneNote 2007 offers drawing tools so you can create drawings on a notebook page, even if you don’t have a Tablet PC.

Office OneNote 2007 makes it easy to create simple drawings in your notebook.  You can use the new collection of drawing tools to add basic shapes and lines, so you can express and capture your ideas visually.  To access drawing tools, simply right click in the Toolbar area, and check Drawing Tools.
You can easily create and manipulate any of the basic shapes using your keyboard and mouse.  A toolbar puts all the drawing tools within easy reach.  It also includes buttons that you can use to manipulate shapes easily and to insert the same shape again until you instruct it to insert a different shape.

Because Office OneNote 2007 treats shapes as ink, you can easily erase the wrong shape with the eraser tool.
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Figure 7: OneNote drawing tools.
Recording Audio and Video
Office OneNote 2007 takes information gathering beyond the traditional boundaries of text and graphics by enabling you to record linked audio and video notes.  Audio and video notes are particularly valuable when you do not want to miss anything that someone says or does.  You can also use the Search feature to quickly find specific words or phrases in the spoken words in recorded audio or video
.  (See “Finding Your Information” below.)  
Recording Audio
If you have a microphone connected to or built into your computer, you can record audio by clicking Insert and then Audio Recording.  This will start the audio recording, and expose the toolbar so you can stop and playback the recording.  Office OneNote 2007 identifies when the audio recording starts, and—as you make notes on the page—it synchronizes what you have written with the audio.  By doing this, Office OneNote 2007 tracks the audio that occurred at the exact moment each note was typed or written. 

Later, if you need to clarify a certain note, simply move your mouse cursor over the text in question.  An icon of a speaker appears in the margin.  Click this icon, and Office OneNote 2007 plays the audio that it recorded while you were writing that line in your notebook. You can also listen to the entire audio by clicking the speaker icon next to the date stamp in the container or by clicking the Play button in the Audio and Video Recording toolbar.  If the See Playback button is selected in the Audio and Video Recording toolbar, Office OneNote 2007 highlights what you have written as the audio progresses.  If you connect your computer to your phone using an inexpensive adaptor, you can record conference calls and link your notes to that audio as well.
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Figure 8: Recording linked audio ensures that you won't miss important items.
Recording Video

If you have a digital video camcorder or webcam attached to your computer, you can record video (and audio, if you have a microphone) by clicking Insert and then Video Recording.  The same recording toolbar as before controls playback and stopping the recording.  Office OneNote 2007 captures the time and date when the video recording starts, and it synchronizes any annotations you make with the video.  If you need to clarify something you have written, you can hover your mouse cursor over the text in question, and an icon of a speaker appears.  Click the icon, then Office OneNote 2007 replays the video recorded when the annotation was made.  You can also replay the entire video by clicking the speaker icon next to the date stamp in the container or by clicking the Play button in the Audio and Video Recording toolbar.  If the See Playback button is selected in the Audio and Video Recording toolbar, OneNote then highlights what you have written as the video progresses.

Organizing and Managing Your Information 
Office OneNote 2007 helps you stay in control of all your information more easily and effectively than ever before.  In addition of giving you a wide variety of methods for capturing information—from recording audio and video to “printing” information to your notebook—OneNote also provides new, powerful tools to organize and manage that information.  With the data you need at your fingertips, you’ll be able to say on top of what’s important and be better prepared.
Navigation Pane and Support for Drag & Drop Organization
Office OneNote 2007 features a new navigation pane that makes it easy to organize and navigate the program.  The navigation pane is similar in look, feel, and behavior to the new navigation pane in Office Outlook, and can be collapsed or expanded according to your needs.  By clicking a notebook icon, you can easily move between open notebooks. Across the top of the OneNote workspace you still see the familiar tabs associated with notebook sections.

By clicking the arrow at the top of the navigation pane, you can expand the view to show more detail about the notebooks and embedded sections.  You can click a section in a notebook and jump to that section, making navigation across multiple notebooks and sections much easier.
Office OneNote 2007 incorporates intuitive drag-and-drop capabilities, which you can use to reorganize your notebooks, sections, and pages quickly.  For example, you can click and hold a section tab and then drag it to another location among the section tabs. 

Staying in Control of Your Information

Because OneNote supports multiple notebooks, you can determine which notebooks to share and which to keep private.  You share only what you want with whom you want.  
You can protect sensitive sections of your notebook with passwords.  Using Office OneNote 2007 section protection encrypts those sections.  When you try to access a protected section, you must first enter your password to view the page contents. 

Office OneNote 2007 saves your password in memory so that you do not have to re-enter it every time you go back to the section.  If you leave Office OneNote 2007 for more than a specified period (the default period is 10 minutes, but you can configure this in OneNote Preferences), Office OneNote 2007 relocks protected sections, and you must enter your password to open those sections.

Hyperlinking

Now you can insert links and jump between OneNote pages—in the same notebook or in other notebooks.  In fact, you can now create hyperlinks to any location or document from within OneNote.  You can also create links to OneNote pages from any other document or location. 
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Figure 9: Office OneNote 2007 makes it easy to embed hyperlinks.

Office OneNote 2007 supports links to specific portions of other documents, presentations, and Web pages.  You can also insert links to individual contacts, e-mail messages, and calendar items in Office Outlook 2007, thus creating a strong web of connections between all the people, places, and events that you need to do your work.  
Tables
Office OneNote 2007 offers support for tables.  You can paste tables from the Web or from other Microsoft Office system applications, and they retain their character as tables.  You can also build your own tables quickly and intuitively, just by pressing the Tab key between the columns you want to create.

For example: if you type the word “Product,” then press the Tab key, Office OneNote 2007 creates a table automatically.  Type the word “Quantity,” press the Tab key once more, and type the word “Price.” You have created a table with three columns in it. 

You could continue to add columns in this manner.  Once you have created the number of columns you need, press the Enter key to begin a new row within the table. 

Office OneNote 2007 also makes it easy to modify and expand tables through keystrokes. Below are some commonly used keystroke shortcuts for modifying tables.
	Action
	Shortcut

	Create more lines inside the last cell of a table.
	Press ALT+ENTER.

	Insert a row at the end of the table.
	Press ENTER or TAB in the last cell.

	Insert a row anywhere in the table.
	Press CTRL+ENTER.

	Insert a row above the current row.
	Press ENTER in the beginning of the row.

	Delete a row.
	Select the row by clicking the row handle and press DELETE or BACKSPACE.

	Delete column.
	Select the column by clicking the arrow that appears at the top of the column and press DELETE or BACKSPACE.

	Swap rows.
	Select the row, press Cut (CTRL+C), then press Paste (CTRL+V) at the beginning of the row before which you want to insert the cut row.

	Split a table.
	Press BACKSPACE or DELETE at the beginning of an empty row.

	Merge tables.
	Press BACKSPACE or DELETE in the empty space between two tables.


 

Finding Your Information

Instant Search makes it possible for you to search through all of the content in your OneNote notebooks, enabling you to find the information you need much faster.
With new and powerful integrated Instant Search, you can quickly locate the information you need, whether it’s text in Web clippings, images, or scanned documents, spoken words in audio recordings, or other information across all of your OneNote notebooks. 
When you enter a keyword in the search box at the top right of the page display, Office OneNote 2007 quickly locates the information you seek—and not just on the page in front of you, but on any page in any section and in any open notebook.
  

Instant Search can search broadly across all your OneNote notebooks or you can narrow your search to particular areas of your notebook.  By selecting Search In from the pull-down menu in the search box, you can specify your search to a particular section, section group, or a particular notebook.  

You can use “NEAR” in the search expression if you want to find only those pages where your search terms are in the same paragraph.  For example, the search phrase “fast NEAR search” would identify only those pages where “fast” and “search” are in the same paragraph.

Highlighting Search Results 

Office OneNote 2007 highlights in yellow the page tabs that contain matches to your search query.  When you press Enter or click the “next match” arrow, Office OneNote 2007 jumps quickly to the next match, across any notebook section, making it easy to search across multiple sections at the same time.

[image: image11.jpg]J Nov 2005 - Microsoft Office OneNote

D Ele Edt Vew Imet Fomst shae Window Heb | &

i@beck -@-[New - G A% LB 9- - v -S| 100% 2 i verdana
| 1@ work i e |

November 2005

Mondsy, Nobember 15t 2005
94940 Cikhere to view hits.

Recodings with possble matches: 0
Way to measure productivity improvements: Sortlstby: R
1. Interms of physical actions | Confidence of match =4

a. Reduced mouse dicks Interview with Jene Doe:
b, Keystrokes sfzsjza0

product description, 05.52 ==
product, 05.52
product, 05.52

EQ descrptian, 06115

descriptian, 06:15

2. Intenms of results
a. Better output
b, Lesstime to produce

Nov 2005

descriptian, 06:15
Figures

Information for the table: Converence Call

3f2ef2005

Region Vice President | Office Location
[Tk descripton, 06:15
North America | Arlene Huff Dallas, TX
descripton, 06:15
Canada seanpurcell | Vancouver, BC Organization descripton, 06:15
alRealign,

Status Meeting
Sf2ef2005

product, 05:52
Italy Martin Bankov | Milan prodeuct, 0552

Japan Joe Healy Kyoto

Germany Erik Andersen | Hannover

Ireland Rob Barker Galway prodiuct, 05:52

Show hits that match with

Audo recording started: 2.5 et dovics
P Honday, Noverber 07, e

2005 Allnotebooks

@ Search tps.





Figure 10: Search for a word or phrase in any OneNote notebook content.

Instant Search utilizes the Windows Desktop Search engine, so that you have a common search experience across Windows, Office OneNote, and other Microsoft Office programs such as Office Outlook.  It indexes your content automatically in the background, including automatically scanning pictures for text using the Optical Character Recognition engine in OneNote, enabling you to find what you’re looking for quickly.
Optical Character Recognition Search
While Office OneNote 2007 treats these imported graphics and imported file printouts as images, Office OneNote 2007 includes an optical character recognition (OCR) engine that automatically scans each image for text.  If the OCR engine finds text within an image, it associates that text with that image and caches that text in the search index.  In this way, the content in inserted images, whether they are CAD files with part names, Web pages pulled from the Internet, or any other kind of printout, become searchable.  If you insert a photograph of a business card and then prompt Office OneNote 2007 to search for the company name appearing on the business card, a link to the image of the business card appears in the search results pane. 
To begin a search, simply type a search term into the Find box and then press Enter or click the button.  Search results display as shown below.
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Figure 11: Search for a word or phrase in any OneNote notebook content.

Audio and Video Search

In addition to enabling you to find text in graphic images, Office OneNote 2007 can find text within audio and video files.  Office OneNote 2007 relies on sophisticated speech-to-text tools and attempts to analyze audio and video files for recognizable content.  For example, if you record a webcast that includes a discussion of the Astrodome, a search for references to the Astrodome would deliver a link to the audio file in which the Astrodome was discussed.  If you click the link in the search results window, Office OneNote 2007 opens the page with the embedded audio file and begins playing the recording at the point where the Astrodome came into the discussion.
Managing your information

Note Flags

OneNote offers a set of Note Flags that you can use to organize and stay on top of the information in your OneNote notebook.    
	For example, you can use Note Flags to prioritize and mark key items, urgent notes, or notes that require follow-up.
You also can customize icons and names for your Note Flags, apply any combination of font color and highlighting to a Note Flag, and add check boxes to appear next to the note.   For example, you could customize a Note Flag as a “supervisor” flag, and, after a meeting, call up all the action items your supervisor had assigned to you. 
The Note Flags Summary Task Pane, shown on the right, makes it easy to manage and view all the items you have flagged with Note Flags, which can be viewed by page, by notebook section, or across all notebook sections.  
Clicking a flagged note in the Note Flags Summary Task Pane takes you to that note in your notebook sections.  In this way, you can connect the Note Flag to the context of each item by navigating through your notes according to the flags.  

	[image: image13.emf]
Figure 12: You can keep track of all important notes and “To Do” items in one place in OneNote.




Syncing Tasks with Outlook 2003 and Outlook 2007

Office OneNote 2007 offers two-way synchronization with Office Outlook 2007.  For example, you can synchronize flagged tasks between OneNote 2007 and Outlook 2007, ensuring that an item flagged as a task in OneNote 2007 automatically appears as a task in Outlook 2007 (and vice versa).  To do this, simply click Outlook Task from the Insert menu item.
Also, you can link meeting notes to appointments in your Outlook 2007 calendar, or you can link a OneNote 2007 note about a customer to their item in your Outlook 2007 contact list.  Later, if you needed to find information about the meeting on your calendar or contact details associated with that customer, you can either click on the link in OneNote 2007, or click the link in your calendar or contacts list in Outlook 2007 to access the information saved in OneNote 2007.

Exporting Content to Other Office Applications

OneNote 2007 enables you to move notebook content to other Office System applications.  For example, you can select a notebook page and can send it to Office Word 2007, by selecting File/Send Page To from the menu bar.
Support for Multiple Computers

You can edit the same notebook on your multiple computers.  This is useful when you have:

· A desktop computer and a laptop at work

· Several computers at home connected to the same home network

· A home laptop and a work computer (if you can connect your home laptop to your network at work)

OneNote will automatically synchronize the changes among your computers when you are online, even if you made the changes while you were not connected.

To open a notebook on multiple computers, all you need to do is put it in a location that each computer can access.  When you create a new notebook, pick the option "I will use it on multiple computers" in the New Notebook Wizard and OneNote will guide you through the process:
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 Figure 13: New Notebook Wizard–selecting for multiple computers
To see whether your notebook is up to date, check the button on the toolbar or File/Sync. You can click the button to check the status of each individual notebook.

 

	[image: image15.png]



	Syncing changes
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Working Together With Others More Effectively

Shared Notebooks

Microsoft Office OneNote 2007 has extended the concept of sharing beyond the real-time sharing sessions delivered in OneNote 2003.  Using OneNote 2007 and a Windows SharePoint Services site or a standard file server, you can share entire notebooks that multiple users can work together in at the same time or at different times. 
A team’s shared OneNote notebook can contain a wide variety of content to help them work more efficiently, including:

· Meeting or project notes

· Project brainstorming ideas

· Any supporting materials collected by team members

· Lists of action items  

· Drafts of project reports that team members can annotate 
· Project plans

· Web research & more
Shared notebooks are easy to use and enable you to work with other people in the same notebook at the same time—there is no “check-out” or “check-in” required—and OneNote seamlessly merges everyone’s changes.  On the rare occasions when two people make changes to the same text container at the same time, OneNote displays an alert that synchronization failed and produces both versions for you to view.

Create a Shared Notebook

You can easily create a shared notebook by following these simple steps:

1) In the file menu, select ‘Share’.
2) Choose ‘Create Shared Notebook’.
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3) A wizard will open and prompt you through the remaining steps.

Invite Others into a Shared Notebook
Office OneNote 2007 makes it easy to invite other people to join a shared notebook. OneNote creates an e-mail message that you can use to invite participants.  By clicking the link in the body of the e-mail message, the people you have invited can join the shared notebook. 
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Figure 14: Sharing notes is easy with Office OneNote 2007.
Offline Access and Synchronization
Team members can work on the shared notebook on their computers, even when they are offline.  As soon as they regain network access, OneNote reconciles the local copies of the notebook with the master copy saved in on the server, and merges any changes into each copy of the shared notebook.  This ensures that every member of the team has a current copy of the notebook—regardless of where they are, or when the new content was added.  Everyone remains on the same page, even when the page gets updated!   

Password Protection

You can always retain control of your notes by sharing your notebook or sections of your notebook, only when you want and to whom you want.  For example, you can allow some people to have access only to certain sections of your notebooks with password protection, and you can revoke access whenever it is appropriate.
Where to Put Shared Notebooks 

A OneNote notebook can be shared simply by storing it in a location from which others can also open it, such as a folder share on your own computer, a file server, or an Office SharePoint site (using Windows SharePoint Services 2.0 or later).  OneNote will guide you through setting up a proper location if you use the Share menu or the shared notebook option in the New Notebook Wizard.
Storing Shared Notebooks on WSS

OneNote provides an easy way to bring new types of valuable content into a company’s long-term content repository, and Windows SharePoint Services increases the security and value of OneNote notebooks.  When stored on Windows SharePoint Services (WSS), the OneNote 2007 notebook is protected under the WSS security policy.  Also, the content stored in OneNote notebooks becomes searchable as part of the WSS content repository.  This makes new types of content available to the organization, such as indexed images and indexed audio and video recordings.  
Live Sharing Sessions in Office OneNote 2007

Another sharing option in OneNote 2007 is Live Sharing Session.  This feature enables you to share a page of notes or multiple pages of notes with other users in real-time.  Live Sharing Sessions utilize peer-to-peer technology, so no server infrastructure is required.  They are also easy to use and can be set up with just a few clicks of the mouse.  You can create or join a Live Sharing Session using the Live Sharing Session option on the Share menu.

You can also use Office OneNote 2007 to broadcast note sessions to other OneNote users, so you can share your notes in real-time without giving others the ability to interact with your notes.  At the end of a shared session, each user retains a copy of the shared notes as part of his or her notebook, so there is no need to take a record of what was discussed.

Other Ways to Share

Sharing Notes Using E-Mail
By clicking the e-mail icon on the Standard toolbar (or using the E-mail Recipient option from the Send Page To command on the File menu), Office OneNote 2007 users working with Outlook 2003 or later can share their note pages with others.  Office OneNote 2007 creates a special file consisting of copies of your selected pages and attaches the file to the message.  It also automatically formats the information on the page (including graphics
) as HTML code and puts it in the body of the e-mail message, so even recipients who do not have Office OneNote 2007 can read the information. 
If a page has linked audio or video files, Office OneNote 2007 also attaches a copy of these to the message if you have elected to do this by clicking Options on the Tools menu. E-mail message recipients who have OneNote can double-click the attachment and add that page to their own notebooks in a special section called Recent Opened Sections. 

If you are using an older version of Outlook or are using other e-mail programs, you can still send OneNote notes to other e-mail recipients by manually attaching the file containing the selected pages to the message.  Neither older versions of Outlook nor other e-mail programs convert the notes on the Office OneNote 2007 page to HTML for inclusion in the body of the message, but you can still copy and paste your notes into your e-mail program.

Publish Notes to a Web site or to a Windows SharePoint Services Web site

You can easily share information with others in a read-only form, by publishing your notes in single-file Web page form that others can view with a Web browser or open and edit in Word 2007.  Using the Publish as PDF or XPS option on the File menu, you can create a copy of your OneNote page in a variety of formats, including a PDF file, a single file Web page, as a separate OneNote section, or as a Microsoft Word 2007 file.  You can post the published file on a file share, Web site, or Windows SharePoint Services Web site.  You can even send the files to others as an e-mail attachment.  OneNote 2007 converts handwriting and drawings into pictures when it publishes the page in HTML format.

Summary

In today’s world of work, people need tools to help them work more efficiently to increase their impact and work more effectively with others.  
Gather Everything in One Place 
You can use Office OneNote 2007 to manage the overabundance of information more efficiently by consolidating all the information you need to do your job in one place.
Find Information Quickly 
You can save time finding information because all of your information is in one place and organized the way you want.  You can organize your note pages any way you want and save time finding information thanks to the powerful keyword search feature.

Work Together More Effectively 
Office OneNote 2007 makes it easy to be on the same page with your colleagues by sharing some or all of your notebooks.  You can improve team productivity because notebooks and information are readily accessible and easy to share.  You can help your team mates to be better prepared, make more informed decisions, and save time by centralizing all of your group’s information. 
Office OneNote 2007 is all about gathering, finding, and working together with others in your company, on all types of information.  It helps you capture, organize, and share a wide variety of information types—from text and graphics to images and audio.  It provides fast and powerful information search and retrieval capabilities, including the ability to scan images and audio files for searchable text, enabling you to manage your information more efficiently and meet your objectives.

Resources

For more information about Office OneNote 2007, please refer to the following resources:

Office OneNote 2007 Highlights Tab

http://www.microsoft.com/office/preview/programs/onenote/highlights.mspx 

Office OneNote 2007 New Interface Tab

http://www.microsoft.com/office/preview/programs/onenote/newui.mspx 

Office OneNote 2007 Why Upgrade

http://www.microsoft.com/office/preview/programs/onenote/why.mspx 

Office OneNote 2007 Demo Tab

http://www.microsoft.com/office/preview/programs/onenote/demo.mspx 

Office OneNote 2007 FAQs

http://www.microsoft.com/office/preview/programs/onenote/faq.mspx 

Office OneNote 2007 Overview 

http://www.microsoft.com/office/preview/programs/onenote/overview.mspx 

Office OneNote 2007 Top 10 Benefits (Reasons to Upgrade)

http://www.microsoft.com/office/preview/programs/onenote/top10.mspx 

System Requirements

For complete system requirements, visit www.microsoft.com/office/preview/beta/sysreq.mspx.
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� This feature is available in English, French, German, Spanish, Japanese, Korean, Chinese Traditional and Chinese Simplified.





� The OneNote Find feature does not search sections or folders you have archived with the Close command on the File menu. 


� Handwriting and drawings in the notes are converted into picture files in the body of the email message, but they retain their characteristics as handwriting and drawings in the attached .one file.
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